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Having a standard, organized onboarding process in place is crucial to making a great first 
impression. With Paycom, you can create New Hire Templates and use Self-Onboarding to give 
your new hires the best possible onboarding experience.  

This guide will walk you through how to make changes to an employee’s profile. We will review all 
of the employee forms, explaining what each form contains, as well as review the different search 
options. After reading this guide, you will be the master of navigating and managing your 
employee’s information!  

User  A cc ess 
To grant and control user access to Employees, first click “User Access and Security” from the 
User Options tile on the main menu. 

From the User Access and Security menu, click “Modify Users.” 
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From the Permission Profiles tab, click into the profile you wish to edit.  

Click the “Employees” tab on the left to view Employee Management permissions. From here, 
check the box next to the appropriate permissions to determine the access level. We’ll explain 
what each permission controls so you can ensure your users have the proper level of access to 
each Employee Management feature.  
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 Add New Employee: Allows the user access to the Add a New Employee menu. Enabling 
this will reveal two more boxes, Add W-2 Employees and Add 1099 Employees. You can 
enable either or both of the options.  

 New Hire Template: Grants the user access to make changes to the New Hire Template.  

 Import Employee Changes: Allows the user to use the Employee Change Import (EMI02) 
to import changes to employees.  

 New Hire Queue Import: If enabled, users can batch import new hire records into the New 
Hire Queue. 

 New Hire Profile Report: If enabled, users can generate the New Hire Profile Report, which 
displays information from new employee records in an easy-to-read format. 

 New Hire Missing Fields Report: If enabled, users can generate the New Hire Missing 
Fields Report, which highlights the missing fields for pending new hires in the New Hire 
Queue. 

 New Hire Audit Report: If enabled, users can generate the New Hire Audit Report, which 
displays all new hire changes that occurred in the New Hire Queue during a specific date 
range. 

 Hire Employee: Gives the user the ability to click “Complete” on the last tab of the New 
Hire Queue and finalize adding an employee. 

 Self-Service: Allows the user to access and make changes within the Employee Self-
Service® Menu. 

 Self-Service Access Profile: Allows users to Add/Edit Self-Service Access Profiles that 
define what an employee has access to within Employee Self-Service®. 

 Restrict New Hire Template Access: Restricts users’ template access, allowing them to 
see only the pending new hires with that template assigned.  

 Employee Directory: Select the appropriate access level from the drop-down menu. 

o None: Users cannot view the Employee Directory. 

o View Only: Users can view the Employee Directory. 

o View and Setup: Users can view the Employee Directory and determine which 
fields display to users and/or employees.  
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Using New Hire Access Profiles allows you to limit the information your users are able to see on 
New Hire Templates.  

Use the New Hire Access Profile drop-down menu to make the appropriate selection. If a new 
profile is needed, click the gear icon. 

Then, click “Create Access Profile.” 
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Provide a description for the Access Profile. Then, from the respective tabs, choose which 
information should be included on the profile using the arrows. The information in the green 
Visible Fields box will display on the profile. When finished, click “Update Access Profile.” 

Now, your newly created Access Profile will be available to assign through Permission Profiles. 
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The Employee Forms tab will allow you to further the access of your users in the following ways:  

 Make Employee Changes: Allows you to designate each form as No Access, Read Only or 
Edit. 

 View Today’s Changes: Enable this permission to provide users access to the Today’s 
Changes page on the Main Menu to view changes for their employees. This permission will 
respect Hide Rates/Taxes and the Sensitive Fields permission. 
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 Hide Rate/Taxes on Forms: Hides rates of pay on employee forms only. This does not 
remove pay rates on HR or Payroll Reports. 

 Hide Form 3 Birth Year and Age: Removes visibility for birth year and age on employee 
forms. This does not remove birth year or age on HR or advanced reports. 

 Employee Change Comments: Grants the user access to enter comments on changes to 
the employee record.  

 Can Override Position Defaults: Allows the user to override defaults associated with the 
position the employee fills.  

 Override Cascading Labor Allocation: Allows the user to override subsequent categories 
for a labor allocation. 

 Allow ESS View as Employee: Allows the user to log into Employee Self-Service® as the 
employee to view it with their permissions. While logged in as the employee, no edits can 
be made and the employee may also be logged in at the same time as the user.  
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Set  Up Employees  

C r e at i n g  a  N e w  H i r e  T e mpl at e  
Creating New Hire Templates allow you to ensure a uniform hiring process among different types 
of employees. For example, let’s say you have both part-time and full-time employees. Do these 
groups of employees get different documents, clock in and out differently, or have various benefit 
offerings? Through New Hire Templates, you can hide specific fields applicable only to certain 
groups of employees.  

First, click “Add New Employee” from 
the Employees tile. 

Then, click “New Hire Templates.” 

Any templates you previously created will display on the New Hire Templates screen. To set up a 
new template, click “Create New.” 
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Next, provide a name for your template. When finished, click “Add.” 

Under the Employer Side tab, go through each of the eight options and choose which information 
should be included on the template.  

Information under the Included Fields box will display on the template. Use the gear icons to set 
default fields to populate automatically. For example, if you only have one location, you can set the 
employee’s work address as a default and it will prepopulate for you.  

When finished, click “Update.”  
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Aut o- G e ne r at e  B ad ge  Numb e r s  
Phone numbers, dates, passwords — with all the different numbers we have to remember, trying 
to remember the last badge number you assigned off the top of your head is a nearly impossible 
task. By auto-generating badge numbers, you don’t need to remember the last badge number you 
assigned as Paycom will track and generate each employee’s badge number automatically. 

To do this, click the HR Information tab. Then, from the Available Fields section, check the box for 
“Badge Number” to add the Badge Number field to your New Hire Template(s).  

Once added, the Badge Number field 
will display in the Included Fields 
section. Click the gear icon to review 
its settings.  
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Select the appropriate option for assignment of badge numbers. Options available for selection 
are: 

 Manual: If selected, you must 
manually enter each employees 
badge number into Paycom. 

 Auto: If selected, Paycom will 
assign employee badge 
numbers automatically.  

If you choose to have Paycom to assign badge numbers automatically, use the Auto-Assign drop-
down menu to select how you want badge numbers assigned. Options available for selection 
include: 

 Use Last 4 of SSN: If selected, Paycom will assign the last four digits of the new hire’s 
Social Security number as their badge number. An alert will display if the last four digits of 
the new hire’s Social Security number match the badge number of an existing employee. 

 Incrementing: If selected, Paycom will assign badge numbers in sequential order. If you 
want badge numbers assigned starting with a specific number, such as 00001, enter it in 
the Start With field. Check the box for “Back Fill” to reuse badge numbers that are no 
longer in use. Incrementing badge numbers can be up to 12 digits.  

When finished, click “Update” to save 
your changes.  
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On Step 7: HR Information of the New Hire Guided Setup, the new hire’s auto-generated badge 
number will display within the Time and Attendance tab based on the settings determined in the 
New Hire Template.   
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Inc l ud e  on  Ne w  H i r e  Re por t  
The Personal Responsibility and Work Opportunity Reconciliation Act of 1996 (PRWORA) requires 
all employers to report new hire data, such as the employee’s name, address and Social Security 
number, to a designated state agency. Add the Include on New Hire Report field in your new hire 
template(s) and set a default selection to ensure new hires are included in new hire reporting.  

To do this, click the “Work Information” tab. Then, from the Available Fields section, check the box 
for “Include on New Hire Report” to add the field to your new hire template(s).  
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Once added, the field will display in the Included Fields section. Click the gear icon to set a default 
value.  

Select “Include” or “Exclude” from the Default Value drop-down menu and click “Update” to save 
your changes.  
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When adding a new employee to Paycom, the Include on New Hire Report field will display within 
Step 2: Work Information. If “Include” is set as the default value, the box for “Include on New Hire 
Report” will be checked to ensure the appropriate employees are automatically included in the 
next new hire reporting period. 
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S e l f- O nb oar di ng 
Customization for your onboarding process is easier than ever with our Self-Onboarding option. 
Empower your employees to begin their first day feeling confident, knowledgeable and engaged 
with Paycom’s Self-Onboarding. Need personal information not requested in the application from 
your new employees? You no longer have to wait for the employee’s first day or navigate various 
communication channels, such as email, to gather information.  

To set up Self-Onboarding, first select ”Yes” for “Enable Self-Onboarding” in your New Hire 
Templates. 

After “Yes” is selected, the Employee Side tab will be made available to you. Here you will 
determine what information is included in the employee’s guided flow, such as your welcome 
video, a message from your CEO, or any other details about your company’s specific onboarding 
process.  

We’ll go through in detail how to set up the Employee Side information in each tab. 
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E m a i l  I nv i t a t i o n  
The Email Invitation tab allows you to create a customized welcome email, inviting your employees 
to begin the Self-Onboarding process. 

 Subject Line: Use this field to enter a custom subject line for the email. If left blank, it will 
default to “Welcome to Paycom.”  
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 Reply to Email Address: A reply-to email address is required to allow employees to 
respond to the invitation email. As a best practice, it is recommended that the reply-to 
email address leads to the person named as the company representative and responsible 
for the employee onboarding experience.  

 Dynamic Fields: Use the drop-down menu to select the dynamic fields you would like to 
include in your email.  

 Reset Template: Clicking “Reset” will discard any changes you have made and reset the 
email back to the Paycom default template. 

When finished, click “Update.” 

We l c o m e  Me s s a g e  
Through welcome messages, you can add multiple videos, images or text-only messages for your 
new hires to view. For example, if you wanted to include a welcome message from your CEO and a 
map showing new hires where to park on their first day, you can!  

Check the box next to “Include Paycom default video” to include our default welcome video that 
explains how to complete Self-Onboarding. 
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Below is an example of what the Paycom default video looks like for employees. 
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To add a custom video or text-only message, click “Add Message.” The following pop-up will 
display allowing you to create your custom message. 

 Title: Enter a title for your welcome message. Keep in mind, employees will be able to see 
this title.  

 Display Media: Determine whether you would like to display a video or image to go along 
with this message.  

 Media Source: Use the drop-down menu to select whether you want to include an image, 
video or web video. Please note: Images are limited to 5MB in size and must be in PNG, 
JPEG, JPG or GIF formats. Video files are limited to 100 MB in size and must be MP4 files 
with H.264 encoding.  

 Dynamic Fields: Use the drop-down menu to select dynamic fields to include in your 
customized message. 

When finished, click “Add.” 
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If needed, click and drag to re-arrange the order your welcome messages will appear. When 
finished, click “Update.” 
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P e r s o n a l  I nf o r m a t i o n  
Through Self-Onboarding, employees will type in their own information through a guided flow, 
reducing the number of secondhand entry errors and providing additional comfort knowing they 
are in control of their personal data.  

On the Personal Info tab, use the Available Fields box to choose the information you want your 
employees to provide during Self-Onboarding. All the information in the Included Fields box will 
display to employees.  

Employee Name, Employee Photo and Language fields are defaulted as Included Fields and cannot 
be removed.  

You will notice that some of the fields in the Included Fields box have a drop-down menu. Use this 
drop-down menu to determine whether the specific field should be Read Only or Editable. Some 
fields, such as Direct Deposit Setup, have the option to mark as “Required.” 
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To help ensure timely completion of Form I-9, you have the ability to include Form I-9 Section 1 in 
Self-Onboarding. To do this, check the box for Employment Verification (Form I-9). This field will 
only display if you have Documents and Checklists enabled.  

If included, the Employment Verification (Form I-9) field will display within the Documents section 
of Self-Onboarding. Once Self-Onboarding is complete and you convert the new hire record to an 
employee record, the completed Form I-9 will be associated with a system checklist. Regular 
system checklists permissions will kick in, allowing you to complete Form I-9 Section 2 or send the 
employee a Form I-9 Section 1 correction, if necessary.  

Examples of information an employee cannot complete through Self-Onboarding include but are 
not limited to:  

 Employee Code  

 Work Information 

 Supervisors  

 Pay Information  

 HR Information  

When finished, click “Update.” 
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D o c u m e nt s  
From the Documents tab, add each document you would like your employees to complete during 
the Self-Onboarding process. This can include government documents, such as the Form W-4, as 
well as any company-specific documents you would like to include.  

Documents must be set up in Documents and Checklists to be added to Self-Onboarding.  

To add a new document, click “Add Document.” 
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The following pop-up window will display. Use the drop-down menu to select the document you 
want to include and click “Add.” 

Each document added will display in the Documents tab. If needed, click and drag to rearrange 
the order the documents will display.  

If the employee is allowed to set up taxes and direct deposit, then the Form W-4 and a direct deposit 
authorization form will be presented to the employee in the document section. Those documents will 
come before any user-added documents. 

When finished, click “Update.” 
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I nv i t i ng  a n  E m p l o y e e  t o  C o m p l e t e  S e l f - O nb o a r d i ng  
From the Employees tile, click “Add New Employee.” 

Then, click “New Employee Queue.” 

To add a new employee, click “Add New Hire.”  
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Select the appropriate New Hire Template with Self-Onboarding enabled. Then, fill out a few 
simple details, such as the employee’s name, email and phone number. To send the employee your 
Self-Onboarding email invitation, select “Create and Send Invitation.”  

B a t c h  S e n d  S e l f - O n b o a r d i n g  I n v i t a t i o n s  

To batch send Self-Onboarding invitations, select your Self-Onboarding New Hire Template and 
enter the required fields in the Create New Hire pop-up window. When finished, select “Create 
New Hire Only” from the drop-down menu.   
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Each new hire created will display within the Pending New Hires tab. When you’re ready to send 
the Self-Onboarding invitations, check the box next to each employee’s name and select “Batch 
Send Invitations” from the Actions drop-down menu.  

Mo ni t o r i ng  S e l f - O nb o a r d i ng  P r o g r e s s  
After the Self-Onboarding invitation is sent to the employee, you can view the employee’s Self-
Onboarding progress from the New Hire Queue by clicking the Details icon.  
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The following pop-up window will display, allowing you to view the steps of the Self-Onboarding 
process, status of the step, time of last action, IP address and the device where the action took 
place. 

Clicking the Onboarding Settings header will expand the section and allow you to view more 
options. 
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 Access: You may reset the process if you need a new hire to start over. This resets the 
Social Security number and Date of Birth initial authentication step, as well.  

 Cancel Process: If you need to cancel the process, you can do so by clicking “Cancel.” 
Restart the process by sending a new invitation at any time.  

 Personal Email: If you need to send the invitation to a different email, click “Change 
Email.”  

 Send Invitation: If anything has been changed or the previous invitation has expired, click 
“Send Invitation” to send a new invitation to the employee.  

 Invitation URL: This shows the link that was sent to the employee, the date and time sent, 
when the link expires, and the option to cancel the link. 

After the employee completes their portion of the Self-Onboarding process, you must navigate to 
the New Hire Queue and finalize the process by entering the information the employee is unable 
to submit, such as HR and pay details.  

Information the employee entered during Self-Onboarding will display in gray fields and cannot be 
edited. 
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E m p l o y e e  V i e w   
After clicking “Create and Send Invitation” from the New Hire Template, employees will receive 
your company’s email invitation. Clicking “Start” will take the employee to the Self-Onboarding 
web page. 

  

Back to TOC
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 36



 

  
 

For security purposes, employees will be prompted to verify their phone number to log in and 
begin Self-Onboarding. 

After phone number verification, the employee can choose whether to view the Self-Onboarding 
web page in English or Spanish. 
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Next, the welcome messages you created will display. If you chose to include Paycom’s default 
video, it will display first. Then, any welcome messages you included will display in the order you 
set. 

After employees view your welcome messages, they will be asked to set their Employee Self-
Service® username, password and security questions. By clicking the arrow next to Username, 
employees can decide whether they would like their username to be their personal email, the 
default username, or an alternate email.   
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From the Self-Onboarding menu, employees can easily see which sections they have completed. 
Clicking “Review” will allow employees to review the information they entered and make edits if 
necessary. The Total Progress bar at the top of the screen provides employees with an estimate of 
how far along they are in the Self-Onboarding process.  

Any section that is incomplete will have a progress bar at the top of the tile. This helps notify 
employees how far along they are from completing that specific section. 
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The tasks in the Information tile will ask employees to enter in their personal information, such as 
address, phone number and emergency contacts. 

If Direct Deposit Setup was included in the Personal Info section of the New Hire Template, 
employees will be able to use the Paycheck tile to submit their direct deposit information.  
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If Tax Setup was included in the Personal Info section of the New Hire Template, employees will be 
able to use the Tax Setup tile to submit federal and state tax information. 

Finally, the tasks in the Documents tile will prompt employees to complete all the documents you 
included in Self-Onboarding. Documents will display in the order you determined in the Self-
Onboarding setup. 
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Read-only and online-editable documents can be completed directly through the Self-Onboarding 
web page.  

Editable documents will require the employee to download the document, complete the 
information and upload it. 

Once all of the sections are complete, employees will click the “Complete” button at the top of the 
page to finalize their portion of Self-Onboarding. A banner will display at the top of the page 
confirming Self-Onboarding is complete. 

Once employees click “Complete” to finalize their portion of Self-Onboarding, they cannot go back 
and edit any information. 
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M anage Empl oyees 

N e w  H i r e  G u i d e d  S e t u p  
First, from the Employees tile, click “Add New Employee.” 

Then, click “New Employee Queue.” 

To enter the New Hire Guided Setup and complete the new hire process, click the name of an 
employee who has completed Self-Onboarding.  
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When you enter the New Hire Guided Setup, the selected template will determine which tabs and 
fields appear. The information is divided into multiple logical steps. Only complete the fields that 
the employee does not have access to. All other fields will be populated when the employee 
completes Self-Onboarding.  

S t e p 1 :  P e r sonal  I n for mat i o n  
On Step 1: Personal Information, you’ll see the employee’s basic information, such as name and 
address. Fields that have been entered by the employee during Self-Onboarding will be gray and 
read-only.  

The employee’s code will generate is sequential order automatically in the New Employee Code 
field.  

If you want to enter the employee code manually, check the box for “Override Auto-generated EE 
Code.” The New Employee Code field will field will become editable for you to enter the desired 
code.  
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If you employ an individual without a Social Security number, such as a non-resident alien, you can 
indicate the employee has applied for a Social Security number. To do this, check the “Applied 
For” box next to the Social Security Number field. Paycom will generate a temporary identification 
number, starting with 000-00-0000 that will serve as a placeholder until the employee receives 
their Social Security number.  

The Applied For check box will only display for W-2 employees.  

Upon checking the “Applied For” box, a pop-up alert will display to inform you the employee will 
be excluded from tax return filing until their Social Security number is updated. 
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S t e p 2 :  Wor k  In for mat i on  
On Step 2: Work Information, enter the employee’s job information, including the hire date as well 
as labor allocation information.  

The employee’s Standard Occupational Classification (SOC) code can be entered, allowing you to 
conveniently add your new employee’s SOC code when entering the employee in Paycom. For the 
SOC Code field to display, you must add the field to your New Hire Template(s).  
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When you add a 1099 employee, you can indicate whether the employee needs to be included on 
the New Hire Report. This is beneficial if you have 1099 employees who work in a state that 
requires you to report their earnings to government tax agencies.  

To do this, indicate whether the 1099 employee should be included on the New Hire Report. Then, 
use the New Hire Reporting State drop-down menu to select the appropriate reporting state. Once 
you complete the New Hire Guided Setup and turn the employee Active, the employee will be 
included automatically in the New Hire Report for the selected state.  

If you are using a custom new hire template that includes the System User field, you can create a 
Paycom user directly through the New Hire Guided Setup. Paycom users are individuals in your 
organization that need the ability to log into Paycom and accomplish tasks, such as approving 
time-off requests, processing payroll or managing employee benefits. 

If the employee’s role includes accomplishing tasks as a Paycom user and the employee is a 
current Paycom user, select “Current User.” Then, use the Paycom User List drop-down menu to 
select the active Paycom user you want to tie to the employee. 
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If a new user needs to be created, select “New User” and enter the information required to create 
a new user.  

When finished, click “Next.” 
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S t e p 3 :  S upe r vi sor s  
On Step 3: Supervisors, assign the employee’s supervisors and determine the appropriate 
Notification Settings.  

Through Notification Settings, you can specify which supervisor should be notified of the 
employee’s time-off requests, timecard approval, employee changes and exception points. To do 
this, click “Set Notifications.” 

In the Notifications pop-up window, check the box for each notification the various supervisors 
should receive and click “Save.” 
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S t e p 4 :  P ay In for mat i on  
On Step 4: Pay Information, select the appropriate pay details and add rates by allocation, if 
necessary.  

When finished, click “Next.” 
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S t e p 5 :  P ayc he c k De posi t  
On Step 5: Paycheck Deposit, select whether the employee will be paid via direct deposit or paper 
check. 

If your employee selects “Direct Deposit,” they can choose to enable net pay and/or distributions. 
Selecting these options will allow them to enter their banking details.  

When finished, click “Next.”  
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S t e p 6 :  T ax e s 
On Step 6: Taxes of the New Hire Guided Setup, Taxes by Geolocation will run automatically based 
on the employee’s home address entered on Step 1: Personal Information and Work Location 
selected on Step 2: Work Information.   

The Lives-in State, Works-in State, SUI Tax Agenc, EE Loca Tax Agency and Client Local Tax 
Agency fields will autofill with the applicable tax information. Review the information and make 
any necessary changes. When finished, click “Next” to continue addin gthe new hire to Paycom.  

If a state is missing from the Lives-in State, Works-in State or SUI Tax Agency drop-down menus, 
please contact your dedicated Paycom specialist.  
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S t e p 7 :  H R I nfor ma t i on  
On Step 7: HR Information, make the appropriate selections within the Employee Self-Service®, 
Time and Attendance, Documents, Benefits and ACA, and Other tabs.  
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S t e p 8 :  C us t om F i e l d s  
On Step 8: Custom Fields, view the employee’s responses to your custom questions. 

When finished, click “Complete” to hire the employee. To save the new employee for later review 
or completion by another user, click “Save.” 

If saved for later, the employee will display in the Pending New Hires tab. 
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N e w  H i r e  B at c h  Ac t i on s  
If you choose save an employee for later, they will display on the Pending New Hires tab. To make 
your hiring processes more efficient, you can batch hire, edit, geolocate and archive — all through 
the New Hire Queue. This is beneficial, for example, if you added 20 new hires to Paycom on 
Friday but don’t want to make them active until Monday, as you can quickly batch hire all 20 
employees directly from the Pending New Hires tab of the New Hire Queue.  

From the Actions drop-down menu, you can perform the following batch actions: 

 Batch Hire: To batch hire multiple employees, check the box next to each employee’s 
name and select “Batch Hire” from the Actions drop-down menu. A green banner will 
display to signify the selected employees were successfully hired. If an employee is missing 
required information, such as birth date or hire date, you must include the required 
information before they can be hired. Once the batch hiring process is complete, the hired 
employees will move from the Pending New Hires tab to the New Employees tab. 

 Batch Edit: With the batch edit feature, you can switch new hires from one Custom New 
Hire Template to another in just a couple clicks. If most of the employee’s information is 
complete — don’t worry. Paycom will pull the applicable information into the new 
template. All you need to do is complete any additional fields. Check the box next to each 
employee’s name and select “Batch Edit” from the Actions drop-down menu. 

In the Batch Edit New Hires pop-up window, select the appropriate template. Each 
Custom New Hire template you’ve created, as well as the Paycom default will be available 
for selection. If you want to apply the default values set in the New Hire template, check 
the box for “Apply Default Values.” When finished, click “Batch Edit.”  

Only new hires not currently in 
Self-Onboarding will be switched 
to the new template.  
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 Batch Geolocate: To batch run Taxes by Geolocation, check the box next to each 
employee’s name and select “Batch Geolocate” from the Actions drop-down menu.  

 Batch Archive: To batch archive multiple employees, check the box next to each 
employee’s name and select “Batch Archive” from the Actions drop-down menu. When 
complete, the selected employees will move from the Pending New Hires tab to the 
Archived New Hires tab. 

 Batch Send Invitations: This action allows you to batch send Self-Onboarding invitations. 
For more information, please see the Batch Send Self-Onboarding Invitations section of this 
guide. 

On the Archived New Hires tab, you can recover or delete new hires.  

 Recover New Hire: To batch recover multiple archived new hires, check the box next to 
each employee’s name and select “Recover New Hire” from the Actions drop-down menu. 
Once complete, the selected new hires will move from the Archived New Hires tab to the 
Pending New Hires tab for you to complete the employee record. 

 Delete New Hire: To batch delete multiple archived new hires from Paycom, check the box 
next to each employee’s name and select “Delete New Hire” from the Actions drop-down 
menu.  
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N e w  H i r e  I mp or t  
The New Hire Import allows you to add multiple employees into Paycom at once using a simple 
import format. Once complete, imported data will save in the New Hire Queue so you can make 
edits before creating the employee record. This allows you to import new records and changes to 
existing records in multiple chunks. All you need to get started is the employee’s Social Security 
number. 

To access the New Hire Import, you must enable the New Hire Queue Import located within the 
Employees tab of Permission Profiles. 

The New Hire Import allows you to import an employee master file directly into the New Hire 
Queue. To do this, select “Import New Hires” from the Add a New Hire drop-down menu. 
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Completing the New Hire Import is a three-step process. On Step 1: Import Properties, click the 
blue “Download” link to download a Microsoft Excel file containing detailed instructions and a list 
of acceptable header values Paycom will recognize automatically. 

Then, select the appropriate Import Type and enter an Import Description. 

New Hire Template drop-down menu contains the default New Hire Template, as well as any 
custom templates you’ve created. The template you select will be used to create records for 
employees who are not assigned a New Hire Template on the import file.  

When finished, upload your completed import file and click “Next.”  

Accepted file types are XLS, XLSX and CSV. 
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On Step 2: Column Mapping, Paycom will map the columns in the import file to the appropriate 
new hire fields automatically.  

Validation errors will be highlighted in yellow. Errors will occur if your import file contains duplicate 
mappings or headers Paycom can’t match to a specific field in the New Hire Guided Setup. 

To fix these validation errors, select the appropriate field from the New Hire Field drop-down 
menu. 

If the New Hire Field drop-down menu is blank, the data will be excluded from the import.  

It’s best practice to address any errors before continuning; however, errors will not cause the 
entire import file to fail. Instead, validated data will import successfully and any data that did not 
validate will record in Step 3: Review and Import.  

You can only import fields you have access to view based on your New Hire Access Profile. Any 
fields you don’t have permission to view will be recorded in Step 3: Review and Import. 
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Step 3: Review and Import contains tabs for New Hires Added, New Hires Changed and Failed 
Records. 

The New Hires Added tab contains data for each new hire you added to Paycom via import. Here, 
you can view each employee’s Social Security or employee identification number, name and the 
number of fields successfully imported.  

The New Hires Changed tab contains data for each employee currently in the Pending Employees 
tab of the New Hire Queue whose information was updated by the import file. Here, you can view 
each employee’s Social Security or employee identification number, name and the number of fields 
successfully imported.  
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The Failed Records tab contains all data that failed to import. Here, each field that failed validation 
or contained an unknown header and the number of failed records associated will display.  

To save your current progress, click “Save.” The import will save within the Import Transactions 
tab of the New Hire Queue for you to complete at a later date. 

To download a Microsoft Excel file containing each successful field, failed values and validations 
and the original source file, select “Save and Download File” from the Save drop-down menu. 

When you’re ready to complete the import, click “Finalize Import.”  

After you finalize the import, each new hire will display in the Pending New Hires tab of the New 
Employee Queue. While in the Pending New Hires tab, you can import additional data, edit and 
delete employees from Paycom. Once all required fields are added, use the batch hire option to 
hire multiple employees at once. 
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M ake  E mp l oye e  C h an g e s  
Whether you need to edit an employee’s demographic or pay information or simply see their latest 
performance review, all of the information about a specific employee is stored within employee 
forms.  

To view an employee’s forms, click “Make 
Employee Changes” from the Employees tile.  

Within Make Employee Changes, you can review general information such as an employee’s 
status, pay class and Employee Self-Service® username. The Quick Links drop-down menu allows 
you to skip clicks and navigate directly to an employee’s form.  
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If employees save a preferred name in Employee Self-Service®, it will display throughout Paycom 
as the employee’s name. Check the box for “Show Legal Name” to view employee names and legal 
names for employees who have both. 

To learn how employees can save a preferred name, please see the Add Preferred Name to 
Employee Records section of this guide.  

 

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 64



 

  
 

Advanc e d  F i l t e r s 
The dynamic filter bar located at the top of the Make Employee Changes screen allows you to 
quickly locate specific groups of employees. For example, let’s say you need to batch edit pay rates 
for the employees who work in your Sales department. With Advanced Filters, you can apply a 
department filter so only employees who work in the Sales department display in the Employee 
Listing.   

After you click the dynamic filter bar, a list of applicable fields will display. To select a field, use the 
arrows on your keyboard to highlight the desired field and press “Enter.” 
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 Or, if you know the name of the field you 
want to include, type it in the dynamic 
filter bar and press “Enter.” 

After you select the field, the 
corresponding operators will display. 

Finally, to complete the filter, you must 
select the value. For basic fields such as 
Department, you can apply multiple 
values to ensure the results meet your 
exact criteria.  

After you select all the filter’s conditions, 
press “Enter” to confirm and apply. 
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After you create the first filter, you can apply additional filters to drill down your results even more. 
Each filter you apply will display beneath the dynamic search bar. To view the values tied to a filter, 
hover your cursor over the blue link. To remove a specific filter, click the “X.” 

If you find yourself creating the same filter on a regular basis — save it! With Advanced Filters, you 
can save your filters so you can easily reuse them at any time. To do this, create your filter and 
click “Save.” 

In the Add Save Filter pop-up window, enter a name for the filter and determine whether you want 
to share it with other users. If you check the box for “Favorite,” the filter will display at the top of 
the Saved list for quick access.  

When finished, click “Save.”  
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Each filter you save, as well as the Paycom default filters, will display in the Saved drop-down 
menu. Any filters you favorite will display with a star.   

To view and manage your filters, click “Filters.”  

The Filters pop-up window consists of three tabs: Quick, My Filters and Available. The Quick tab 
allows you create a quick filter that includes the Employee Status and/or Department field.  

The My Filters tab allows you to view and edit your saved filters.   
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The Available tab contains the Paycom default filters, as well as any filters other users created and 
shared. Here, you can mark a filter as a favorite and determine whether it displays in your Saved 
list.  
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Empl oye e  Me nu  
Click an employee’s name to access the Employee Menu and view the employee’s forms.  

Within the Employee Menu, each available form will display. Click the name of the form you would 
like to view or edit.  

We’ll break down each form for you. 

The forms available vary depending on your user access and the modules your company uses with 
Paycom. If your company uses Personnel Action Forms, changes to Employee Forms are made most 
efficiently there.   
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F o r m  1 :  D e m o g r a p hi c s ,  P a y  R a t e s  a nd  T a x e s  
Form 1: Demographics, Pay Rates and Taxes is broken into sections – Employee Demographics, 
Labor Allocation, Employee Pay Rates, Employee Other, Employee Taxes, Federal Tax Information, 
State Tax Information and Custom Fields. 

E m p l o y e e  D e m o g r a p h i c s  

This section holds information about the employee and their status within the company.  

When an employee’s status is changed to terminated, retired or deceased, the termination date has 
to be entered to ensure the proper information is stored with the status change.  

Here you will enter information such as status, home department and work location as well as the 
employee’s position seat. These fields can be changed at any time.  

Within each form, there is an option to see a “View Change History.” This allows you to view any 
changes made on this form quickly.  
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If you indicated the employee has applied for a Social Security number in the New Hire Guided 
Setup, their temporary identification number will display in the Social Security Number field. Once 
the employee receives their Social Security Number from the Social Security Administration, 
uncheck the “Applied For” box and enter their number in the Social Security field. Once saved, the 
change will register across Paycom.  

If an employee does not have a work location saved within Form 1: Demographics, Pay Rates and 
Taxes and you attempt to update the form without adding a work location, the following error 
message will display. To save your changes, you must assign the employee a work location.   
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L a b o r  A l l o c a t i o n  

Labor Allocation details will also appear on this form. If you need to make changes, click 
“Change/Edit.” 

Select the appropriate information from the drop-down menus and click “Save.” Each field is 
customized to the categories designated by your company. 

If you have multiple EINs with Paycom, each employee must be assigned to a default Payroll 
Profile. To select or change the default, select the appropriate payroll from the drop-down menu. If 
you need to set up a Labor Allocation Profile, within the User Options menu, click “Labor 
Allocation Filter Profiles.”  
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E m p l o y e e  P a y  R a t e s  

This section holds information like the employee’s pay type, salary or rate information, and pay 
frequency.  

Within this section, there are three tabs. On the Base Pay tab you have the option to show your 
salary employees’ per-pay period or per annum salary and hourly rates.  

If you are a Multi-EIN customer, and the employee is eligible to be paid out of Payroll Profiles, you 
will mark those by clicking “Change/Edit” next to Eligible Payroll Profiles.  
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On the Rates by Allocation Tab, specify different pay rates for when the employee works in 
different positions.  

On the Base Pay Changes tab you can see the current rates and rate history for the employee.  

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 75



 

  
 

E m p l o y e e  O t h e r  

In this section you have the ability to raise or lower your Excessive Net Threshold companywide or 
you can assign individual thresholds to specific employees. The company threshold is defaulted to 
$10,000. 

To raise or lower your Excessive Net Threshold companywide, contact your dedicated Paycom 
specialist. 
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E m p l o y e e  T a x e s  

This section holds the employee’s local and state tax profiles. These profiles contain Lives-in, 
Works-in and SUI state information. This is beneficial for employees who travel and work in 
different states or for an employee who recently moved to a new state. 

Employees can elect to have an additional amount or percent come out for federal or state taxes.  
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Through the Tax Setup Form on Employee Self-Service®, employees can check whether they are 
exempt from taxes based on their Form W-4.  
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Once checked and updated, this will flow to Form 1: Demographics, Pay Rates and Taxes in the 
Block column.   

In the Federal Tax Information section, you will also see the Form W-4. This allows you to compare 
what the employee is selecting to what is showing within Form 1: Demographics, Pay Rates and 
Taxes. The employee must both acknowledge and sign the Federal Tax changes within Employee 
Self-Service®. 

Any changes you make will require the employee to complete a new Form W-4. We encourage any 
employee who requests a Federal Tax Change to be directed to Employee Self-Service® to make the 
change so Form 1: Demographics, Pay Rates and Taxes will reflect an accurate Form W-4.  
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T a x e s  b y  G e o l o c a t i o n  

Taxes by Geolocation uses the latest geocoding technology to tie your employees’ tax profiles to 
their work and home addresses to find potential tax liabilities. This ensures your employees are 
assigned the appropriate tax profile and limits prior period adjustments due to inaccurate tax 
setup.  

C o n v e r t  D e l i v e r y  L o c a t i o n s  t o  W o r k  L o c a t i o n s  

For Paycom to generate the appropriate tax information, employees must be assigned a work 
location. Work locations are used throughout Paycom to document the physical place employees 
work. As a best practice, all locations should be saved in Company Maintenance and assigned to 
employees so you can use each module to its fullest potential and ensure accurate reporting. 
Taxes by Geolocation will use each location’s address to determine the employee’s works-in state 
and SUI tax agency. 

If you don’t have work locations created yet, you can convert the delivery locations Paycom has on 
file to limit the amount of required setup. Navigate to User Options > Company Maintenance > 
Locations/Establishments to begin the conversion.  

The yellow banner at the top of the Locations tab displays the number of delivery locations that 
aren’t saved as a work location. Click “Convert Delivery Locations” to continue.  
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Each unconverted delivery location will display in the conversion table. The Status column may 
contain the following icons: 

 Green Checkmark: Delivery location is valid and has a description.  

 Yellow Warning: Delivery location does not have a description. If converted, the first line of 
the address will be used as the description.  

 Red X: Delivery location is a P.O. Box and cannot be converted to a work location.  

Review the information and check the box next to each delivery location you want converted to a 
work location. When finished, click “Convert Selected.”  
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Once complete, Paycom will convert the information and the new work location(s) will display 
within the Locations tab where you can edit or delete. For more information on how to manage 
work locations, please see our Company Maintenance guide available on the Help Menu.  
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A s s i g n  W o r k  L o c a t i o n s  t o  E m p l o y e e s  

Once your company locations are saved in Company Maintenance, assign them to employees in 
Form 1: Demographics, Pay Rates and Taxes. Select the appropriate location from the Work 
Location drop-down menu and click “Update” at the bottom of the screen to save your changes.  

To assign the same work location to multiple employees quickly, navigate to Make Employee 
Changes, check the box next to the appropriate employees and select “Batch Edit Menu” from the 
Batch Actions drop-down menu.  
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On the Batch Edit Menu, click “Employee Properties.”  

Scroll to the Work Location drop-down menu. Then, select the appropriate location and click 
“Update” at the bottom of the screen.  
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R e v i e w  A d d r e s s  C h a n g e s  

When employees update their address in Employee Self-Service® or change work locations, a new 
tax profile must be created in Form 1: Demographics, Pay Rates and Taxes. As a best practice, you 
should generate the Employee Changes Report on a regular basis. This allows you to track 
address changes so you can ensure your employees’ tax profiles are up-to-date.  

To access this report, navigate to the Report Center and click “Employee Changes Report” from 
the Audit Reports tab. 

In the Report-Specific options, scroll to the Filter By Employee Change section to drill down the 
report and easily view address changes.   
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Once generated, compare employees’ old and new addresses.  

C r e a t e  N e w  T a x  P r o f i l e s  

After reviewing the address change, you’ll need to edit the employee’s tax profile. To do this, 
navigate to Make Employee Changes and click the appropriate employee’s name.   
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From the Employee Menu, click “Demographics, Pay Rates and Taxes.”  

In the Employee Taxes section, you can view the employee’s current tax profile. You cannot edit a 
tax profile that has been processed through payroll. Instead, you must create a new tax profile for 
the employee. To do this, click “Change.” 

Then, on the Employee Tax Profile screen, click “Create New Tax Profile.” 
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The employee’s home address and work location saved within Form 1: Demographics, Pay Rates 
and Taxes will display in the Create New Tax Profile pop-up window. If the employee is not 
assigned a work location, use the Work Location drop-down menu to assign the appropriate 
location.   

Taxes by Geolocation will run automatically based on the employees’ home address and work 
location and the Lives-In State, Works-In State, SUTA State, Employee Local Taxes and Employer 
Local Taxes fields will autofill with the applicable tax information. Review the information and 
make any necessary changes. When finished, click “Add” to create the new tax profile.  

If a state is missing from the Lives-In State, Works-In State or SUTA State drop-down menus, please 
contact your dedicated Paycom specialist.  
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F o r m  2 :  S c he d u l e d  E a r ni ng s  a nd  D e d u c t i o n s  
On Form 2: Scheduled Earnings and Deductions, add any scheduled earnings, deductions and 
garnishments for this employee. 

S c h e d u l e d  E a r n i n g s  

Scheduled Earnings are earnings set up to be paid on an employee’s check on a regular frequency. 
These will add the entered amount on the payroll automatically without the need to insert it 
manually each time.  

To add an earning, click “Add.” 

Then, select the applicable earnings 
and click “Add.” 

If you do not see an earning needed 
in the pop-up window, contact your 
dedicated Paycom specialist.  
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Then, enter the specific information about the earning. 

 Amount: The amount entered will be awarded to the employee.  

 Percent: If the earning is a percentage of gross earning, then the percentage amount will 
show here. Only your dedicated specialist is able to change the percentage amount.  

 Earning Start Date: Enter the date the earning should start being automatically inserted 
into payroll. The earning start date is based on check date, not pay-period. 

 Earning Stop Date: Enter the date the earning should automatically stop being inserted 
into payroll. The earning stop date is based on check date, not pay-period. 

 Frequency: How often the earning will be applied to payroll based on how the earning was 
set up by your dedicated specialist.  

 Department: You can set a fixed allocation for an earning. This is beneficial if you pay 
employees fixed stipends and want those stipends to go to a specific allocation instead of 
the employee’s home or worked-in allocations. 

P i e c e  R a t e  U n i t s  

If your company uses units to track your employee’s time, you’re able to set this up in Form 2: 
Scheduled Earnings and Deductions, as well. With our unit-tracking feature, you will receive a 
detailed report of the true hours worked combined with units produced and the piece-rate 
earnings associated.  

To enable this feature, please contact your dedicated Paycom Specialist.  

After this feature is enabled, you will assign the Piece Rate as a scheduled earning and the 
timecard will display the rate from the earning code assigned to the employee. 
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S c h e d u l e d  D e d u c t i o n s  

Scheduled Deductions are amounts set to be deducted from the employee’s check at a certain 
frequency. These will be deducted automatically from payroll on the frequency specified. Common 
scheduled deductions include health and 401(k) deductions.  

If you are using Paycom’s Benefits Administration, be sure to refer to the Benefits Administration 
section on the Help Menu for information on how to enroll, approve and send benefits to payroll.  

To add a deduction, click “Add.” 

Then, select the applicable deductions and click “Add.”  

If you do not see a deduction needed in the pop-up window, contact your dedicated Paycom 
specialist.  
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Insert the amount or percent that should be deducted on each payroll. 

 Amount: The specific amount of money to be deducted from the employee’s check at a 
certain frequency.  

 Percent: The percent of an employee’s earnings to be deducted from the employee’s 
check at a certain frequency.  

 Override: Deduction amounts and percentages for deductions tied to benefit plans will be 
grayed out and locked to eliminate unnecessary changes in Paycom. To make changes to 
these amounts, click the “Override” option found below the amount. If you want the 
change to reflect in Benefits Administration, click on the plan name from the Benefit Level 
and Plan Name column. Any changes will be logged in the Benefit Changes Audit Report. 

 Set Limit: If the deduction calls for a limit such as a loan, you can insert the limit amount in 
the “Set Limit” column. The deduction will stop being taken from the paycheck once the 
limit is reached.  

 Match Policy: If the deduction is a 401(k) and you want to override the policy at which the 
401(k) is matched, you can override it in this column.  

 Direct Deposit: If the deduction is set up to be direct deposited automatically into an 
account, you can set the routing and account numbers for this deduction.  

 Benefit Level and Plan Name: This is for deductions tied to benefit plans. The plan name 
and benefit level will display. Selecting the plan name hyperlink directs you to Form 13: 
Employee Benefits.  

 Benefit Effective Date: The date the benefit is effective.  

 Coverage End Date: This is the date that the coverage for the benefit will end.  

 Deduction Start Date: Specify the date you want the deduction to begin. The deduction 
will then come out on the first payroll with a processing date after the date entered.  

 Deduction Stop Date: Specify the date the deduction will stop being taken from the 
paycheck, based on the check date.  

 Frequency: Frequency in which the deduction is deducted. Frequencies are set up on the 
deduction by your dedicated specialist.  

 Goal Amount: Amount that the limit is established for the deduction.  

 Goal Accum: The total amount deducted for the current year.  
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 Remaining Balance: Remaining balance until the limit is met.  

 COBRA Eligible Benefit: Checked whether it is a COBRA-eligible deduction in which the 
employee is enrolled. 

S c h e d u l e d  G a r n i s h m e n t s  

Scheduled Garnishments are amounts set to be deducted from the employee’s check at a certain 
frequency. These will be inserted automatically into payroll on the frequency specified. 

If your company uses Paycom’s Garnishment service, please see the Garnishments guide on the 
Help Menu. If your company does not use our service, contact your dedicated Paycom specialist. 

F o r m  3 :  D a t e s  a nd  HR  
Form 3: Dates and HR contains important employee dates, human resources and supervisor 
information. In your employee’s Form 3: Dates and HR, the gender, race/ethnicity, disability and 
VETS 4212 Classification compliance fields will be stored separate from the employee record and 
not generally accessible, according to the Equal Employment Opportunity Commission and Office 
of Federal Contract Compliance Programs guidelines. With access, you can review this 
information on the Sensitive Compliance Fields tab.  

Use the tabs within Form 3: Dates and HR to navigate easily. 

Additional tabs include Employee Dates, Human Resources Information, Contact Information, 
Organizational Relationships, Government Reporting and Custom Fields. 
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E m p l o y e e  D a t e s  

Within Employee Dates, enter any applicable date information you would like to remain in Paycom. 
Employers usually record important dates, such as Hire Date, Rehire Date, Seniority Date, 
Termination Date and Birth Date. Dates the employee was added and reported on the New Hire 
Report are stored automatically, as well.  

The Most Recent Check Date field allows you to see an employee’s last check date. This is 
beneficial when you have several seasonal employees who may not receive a check for a long 
period of time. This allows you to audit active employee records and keep head counts accurate. 
This field is an option on the Advanced Report Writer.  

  

  

  

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 94



 

  
 

The Seniority Date field ensures your employees’ length of service aligns with your organization’s 
policies. By default, the employee’s hire date will display in the Seniority Date field. However, you 
can enter a custom date, if necessary. The employee’s years of service display next to the Seniority 
Date field so you can quickly view the employee’s tenure.  

Elapsed time between hire and rehire date is not included in the length of service calculation. 

If the employee has a date entered in the Rehire Date field, you can determine whether Paycom 
updates the seniority date to reflect the rehire date.  

After you update the employee’s form, the following pop-up window will display. If you want to 
factor previous time into seniority, click “Update Rehire Date Only.” The seniority date entered will 
remain as is and Paycom will update the rehire date. If you click “Update Both,” Paycom will 
update the seniority date to match the employee’s rehire date.  
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The Last Worked Date field allows you to record last worked dates in addition to termination 
dates. For example, if you have a no-call, no-show policy, you may terminate employees for job 
abandonment if they don’t show up to work after two days. In this situation, the employee’s last 
worked date would be two days prior to their termination date. Recording the employee’s last 
worked date in Form 3: Dates and HR ensures the employee isn’t paid for the two days they didn’t 
work.  

Click “Options” next to the Termination Type drop-down menu to determine which options are 
available for selection.  
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Enter a termination type in the Options field and click “Add New Option.” 
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H u m a n  R e s o u r c e s  I n f o r m a t i o n  

In Human Resources Information, you will enter information, such as Department of Labor Status, 
ACA Status, marital status and more.  

Also, you can update your employees’ benefits eligibility when you change their DOL Status. After 
selecting the new status, additional options will appear for you to select from. 
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C o n t a c t  I n f o r m a t i o n  

In the Contact Information tab, the employee’s work and personal email will display, which is 
useful in other modules throughout Paycom. Your employees and managers can receive email 
notifications on their personal and/or work email address. You can specify whether emails should 
go to work, personal or both, and therefore notify appropriately. 

While we hope you never have to reach out to an employee’s emergency contact, this information 
is stored here, as well. If the employee has designated a primary emergency contact, that contact 
will display first with “Primary” next to their name.  
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O r g a n i z a t i o n a l  R e l a t i o n s h i p s  

From here, you can assign supervisors. This is important for Paycom’s Time-Off Requests. If you 
use this module, assign a Time-Off Supervisor so they can approve time-off requests. You can 
mark whether the supervisor should receive an email notifying them the employee has requested 
time off. You can do this for each supervisor and also receive emails when the employee approves 
their timecard or when they make changes to specific fields. 

If no email address is shown next to a supervisor’s name, it will need to be added. The Time-Off 
Approval Supervisor’s email address will be added under User Access and Security. Primary, 
secondary, tertiary, quaternary and talent management supervisor’s email addresses should be 
added in Form 3: Dates and HR. 
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G o v e r n m e n t  R e p o r t i n g  

This screen allows you to enter the employee’s Standard Occupational Classification code. You 
can also designate the employee as a new hire for reporting purposes.  

S e n s i t i v e  C o m p l i a n c e  F i e l d s  

Information on this tab should not be changed after an employee has identified. If your company 
participates in EEO-1 reporting and an employee chooses not to answer the questions, you may 
select an option for them in the EEO-1 fields.  

When you are finished making changes to this form click “Update.” 
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F o r m  4 :  P e r c e nt a g e  L a b o r  D i s t r i b u t i o n  
Percentage Labor Distribution allows you to allocate an employee’s earnings to multiple 
departments on each payroll. Check the “Enable Labor Distribution for this Employee” box. Then 
select the department to allocate the earnings and the ratio in which to assign.  

The ratio is in decimal format and the total allocated amount must equal 100. You also need to 
assign the tax profile for the allocation. When you are finished making changes click “Update.”  

If using Paycom’s Labor Allocation feature, be sure to make a selection in each drop-down menu. 

F o r m  5 :  3 r d  P a r t y  P a y e e s  
If you receive a garnishment order for one of your employees and you need a check cut for the 
garnishment amount to a third party, insert the information for the 3rd Party Payee on this form. 
You can make changes to an existing 3rd Party Payee by clicking “Make Changes” or add a new 
3rd Party Payee by clicking “Add New 3rd Party Payee.” 

For more information on 3rd Party Payees and Garnishments, visit the Garnishments guide on the 
Help Menu. 

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 102



 

  
 

F o r m  6 :  A c c r u a l  I nf o r m a t i o n  
Assign accrual profiles to employees through Form 6: Accrual Information. Within the Accruals 
Summary table, view applicable dates, limits and transaction history for each accrual tied to the 
employee.   

When you are finished making changes to this form click “Update.” 

F o r m  7 :  E m p l o y e e  P ho t o  
You can upload a photo of the employee that will appear on the employee’s menu and main menu 
of Employee Self-Service®. This feature can help ensure changes are made to the correct 
employee’s file.  

To upload a photo, click “File” and locate the file you wish to upload. Clicking “Preview” allows you 
to preview the file. There is a maximum file size of 3 MB for the photo and only PNG, JPG, JPEG and 
GIF file types are accepted.  
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F o r m  8 :  C u s t o m  F i e l d s  
Custom fields allow you to store additional HR information using drop-down, text and date fields. 
You have the option to create up to nine pages of Custom Fields to store information. Information 
entered in Custom Fields can be used to create reports and track additional information you may 
need about employees.  

To go to other Custom Fields pages, click the appropriate tab beneath the Custom Forms header. 
To create more selections or remove selections from the drop-down menus of the Custom Select 
Fields, click the gear icon. 

To add a new option to the drop-down menu, enter the description and click “Add New Option.” 
To delete an existing option, click the “X” next to the option to be removed. 

When you are finished making changes to this form, click “Update.” 
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F o r m  9 :  E m p l o y e e  S e l f - S e r v i c e ®  
Employee Self-Service® offers employees online access to their personal information, including 
contact information, pay rates, tax setup and a listing of their checks. The Employee Self-Service® 
feature is used throughout Paycom.  

Make sure employees’ logins are enabled. You can also assign employees to an Expense 
Management Class (if using Expense Management) and an ESS profile, if needed. 

 ESS Login Enabled: This drop-down menu allows you to enable or disable an employee’s 
login. Enabled means the employee can log in to Employee Self-Service®.  

 Username: The employee’s username used when the employee logs in. This was set up 
when adding the new employee. This form provides you quick access to retrieve the 
username if forgotten by an employee.  

 Password: The allows you to override the employee’s password and make it a one-time 
password. Paycom will then prompt the employee to change the password as soon as 
they login.  
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 Expense Management Class: If you have Paycom’s Expense Management module, you 
can select the Expense Management Class you would like to assign to the employee. 
Expense Management allows you to manage your employee’s expenses by tracking how 
much is spent and where.  

 Profile: Profiles allow you to control what the employee can and cannot see on Employee 
Self-Service®. If you have created ESS Access Profiles, assign the profile to the employee 
by making the appropriate selection from the drop-down menu. If no ESS Access Profile is 
assigned, the default profile will apply.  

 View ESS as Employee: This permission allows the user to log into Employee Self-Service® 
as the employee to view the employee’s permissions. While logged in as the employee, no 
edits can be made, and the employee may also be logged in at the same time as the user.  

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 106



 

  
 

F o r m  1 0 :  T i m e  a nd  A t t e nd a nc e  
Time and Attendance allows you to track employees’ time. This module can connect to hardware 
terminals, or your employees can clock in and out through Employee Self-Service®.  

On Form 10: Time and Attendance, you will need to be sure to assign the new employee to a Pay 
Class, Terminal Access Group and Schedule Group, if applicable.  

If you are using a standard hardware clock, you will need to enter the employee’s badge number.  

A message will display at the bottom of the screen reminding you to update the hardware clock 
terminal when making changes that potentially could impact the hardware clock.  
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F o r m  1 1 :  D i r e c t  D e p o s i t  
Form 11: Direct Deposit allows you to view bank account information for the employee to receive 
their paycheck. There are two options for direct deposit:  

 Main Account (Net Pay): The account where the total direct deposit is sent if no 
distributions are set up. If distributions are set up, the distributions are taken off the net 
amount first and then the remaining amount is sent to the account in the NET pay.  

 Direct Deposit Distributions: Additional accounts to have a fixed dollar amount or percent 
of the net amount to be allocated. There can be up to eight distributions set up per 
employee. 

To increase or decrease the number of Direct Deposit Distributions your organization has 
enabled, please contact your dedicated Paycom representative.  

The Deposit Method drop-down menu indicates whether the deposit method for a main account 
and/or distribution is a bank account or pay card. This ensures each deposit method is saved in 
Paycom for easy reporting.  

As a best practice, employees should update their direct deposit information in Employee Self-
Service®. Changes to Form 11: Direct Deposit should only be made is special circumstances.   
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F o r m  1 2 :  Y e a r - t o - D a t e  T o t a l s  
On the Check Listings tab you can view all checks listed within that year. You have the option to 
view multiple earnings statements simultaneously for an individual employee, making it 
convenient to print multiple statements at once, rather than one at a time. Check the box next to 
each check you would like to view, then click the print icon. The next screen will display the full 
breakdown of all checks paid to the employee.  

The Year-to-Date Totals tab shows the year-to-date totals for the employee for the current year. 
The four categories within this form are Earnings, Employee Taxes, Deductions and Net Pay. To 
select prior years, select a different year from the drop-down menu at the top of the form.  
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F o r m  1 3 :  E m p l o y e e  B e ne f i t s  
If you have Paycom’s Benefits Administration module, you can view the employee’s current 
benefits, view qualifying events and assign them to an Eligibility Profile all from Form 13: Employee 
Benefits. The Benefits Administration module allows you to ensure the correct deductions are 
taken from employees’ paychecks for benefits. This module also allows you to report on 
information about benefits.  

Form 13: Employee Benefits is broken into the following tabs:  

 Employee Benefits  

 Dependent Benefits  

 Beneficiary Benefits  

 Enrollment  

 Qualifying Events  

 COBRA 

At the top of the screen, click the blue Benefits Eligibility Profile link to change the employee’s 
Benefits Eligibility Profile. 

A pop-up window will display. Use the Benefits Eligibility Profile drop-down menu to make the 
appropriate selection. Then, click “Update.” 
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Through the Batch Actions drop-down menu, you can efficiently batch approve and terminate your 
employee’s benefit plans, as well as send benefits to payroll and change dates. The options 
available for selection will vary based on the available actions within the employee’s Form 13: 
Employee Benefits. For example, in the image below, the employee does not have any benefits to 
approve, so the option to Approve does not display in the Batch Actions drop-down menu. 

Quickly view the details of a benefit plan by clicking the blue hyperlink in the Plan Name column. 

Additional details for the selected benefit plan will display. Navigate directly to the benefit plan 
setup by clicking the Employee Benefit name. The selected benefit plan will open in a new browser 
window. 

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 111



 

  
 

F o r m  1 4 :  D e p e nd e nt s  a nd  B e ne f i c i a r i e s  
Form 14: Dependents and Beneficiaries contains the employee’s dependent and beneficiary 
information. This information works with Paycom’s Benefits Administration module. You can allow 
employees to manage this information in Employee Self-Service®. 

D e p e n d e n t s  

View or add dependents on the Dependents tab of Form 14: Dependents and Beneficiaries. If you 
need to add a new dependent, click “Add Dependent.” 

You have the option to allow dependents to be added without a Social Security number. A check box 
labeled “SSN Not Available” will appear if this option is enabled. Contact your dedicated Paycom 
specialist to enable this feature. 
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Use the Relationship drop-down menu to select the appropriate dependent relationship. If you 
select “Court Ordered Dependent,” the Visible Fields in ESS option will display. Here, you can 
control the specific dependent demographic information that the employee can view in Employee 
Self-Service®. This is beneficial, for example, if an employee is ordered to cover their ex-spouse on 
their benefit plan, but you do not want the employee to be able to access the ex-spouse’s Social 
Security number or address.  

Use the Visible Fields in ESS box to select which fields should be visible to the employee in 
Employee Self-Service®. The First Name field is required to display in Employee Self-Service® and 
cannot be unselected.  
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The newly added dependent will display on the employee’s Form 14: Dependents and Beneficiaries 
under the Dependents tab. Click a dependent’s name to edit the information.  

Make the appropriate changes in the Edit Dependent pop-up window. If you attempt to edit the 
dependent’s relationship, a warning message will display to inform you that the dependent is 
currently tied to a benefit plan. Changing the dependent’s relationship will not remove the 
dependent and could allow a dependent of the wrong relationship type to remain tied to the 
benefit plan.  

Additionally, if the dependent is tied to an active or future benefit plan, the Recipient Status drop-
down menu will be disabled. This ensures only active dependents are tied to benefit plans.  
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Click the “View Benefits” link to view a summary of the dependent’s benefits.  

The dependent’s eligible, current and declined benefits will display for review.  

B e n e f i c i a r i e s  

To view the employee’s designated beneficiaries, click the “Beneficiaries” tab on Form 14: 
Dependents and Beneficiaries. From this tab, click the “View Benefits” link to navigate to the 
employee’s Form 13: Employee Benefits to view benefit plans quickly and easily. 

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 115



 

  
 

F o r m  1 5 :  D o c u m e nt s  
Form 15: Documents allows you to add and store documents for an employee. You can assign the 
employee to a Document Group, change an employee’s current Document Group and add or view 
documents assigned to the employee. 

For more information, visit the Documents and Checklists Guide on the Help Menu 

F o r m  1 6 :  C he c k l i s t s  
Form 16: Checklists allows you to assign a checklist of tasks to an employee. You can assign the 
employee a checklist and view completed tasks from this form. 

For more information, visit the Documents and Checklists Guide on the Help Menu. 
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F o r m  1 7 :  Y e a r - E nd  T a x  F o r m s  
Form 17: Year-End Tax Forms allows you to view, edit or enter additional information for the 
employee that needs to be reported on their Form W-2, Form 1099 or Affordable Care Act (ACA) 
form. These entries will appear on the applicable tax forms at the end of the year.  

The IRS allows Social Security numbers and Taxpayer Identification numbers to be masked on 
Form W-2 and 1099 to help protect employees from identity theft. If you check the box for “Mask 
SSN/TIN,” only the last four digits of the employee’s Social Security number or Taxpayer 
Identification number will display on the employee’s copy of Forms W-2 or 1099.  
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Through the ACA tab, you can view the period used to calculate an employee’s current ACA status 
by hovering your cursor over the ACA status. 

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 118



 

  
 

F o r m  2 0 :  C o m p e n s a t i o n  a nd  P e r f o r m a nc e  Hi s t o r y  
Form 20: Compensation and Performance History allows you to view an employee’s position, 
department, performance and compensation history and all of the employee’s performance 
reviews. This form works with Paycom’s Talent Management suite. 
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F o r m  2 1 :  L e a r ni ng  
Form 21: Learning allows you to track an employee’s learning progress and view employees’ 
certifications. View assigned, requested and completed learning along with quiz results and notes. 
Certification status, date and time of verification and certification/license numbers can be viewed 
under the Certifications tab. 

For more information about Paycom Learning, see the Paycom Learning Guide on the Help Menu. 
For more information about certifications, see the Certification Management Guide on the Help 
Menu. 

U p d a t i ng  F o r m s  
When you are finished making changes to forms click “Update” to ensure your changes are saved. 
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Now, you’ll be taken to a confirmation screen. From here, you can click “Return to Form” to go 
back and make additional changes, “Employee Menu” to return to that employee’s menu or “Select 
A Different Employee” to go to a different employee’s form. 
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E m p l o y e e  P r o f i l e  
After you have selected the employee in Make Employee Changes, you can click “View Full Profile” 
to view the profile for that employee. 

This profile will show the first six forms within Make Employee Changes in a quick-view format 
that allows you to review the employee’s information. 
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E m p l o y e e  S e l f - S e r v i c e ®  P r e v i e w  

If you need to assist your employees, you have the option to view content as they do by using the 
View ESS as Employee option in Form 9: Employee Self-Service®. This access is read-only; 
therefore, you won’t be able to make changes or edit information, but you will be able to easily 
provide troubleshooting assistance and guidance to your employees. 

To access this feature, you must have “Allow ESS View as Employee” enabled within your 
Permission Profile, as well as access to view sensitive fields and edit access to all employee forms. 

For example, you can walk your employees through viewing their available vacation hours or show 
them how to submit a time-off request. 

This feature is available within most parts of Employee Self-Service® with the exception of Benefits. If 
you need to walk your employees through enrolling in their benefits, please reference the Benefits 
Guide on the Help Menu. 
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B a t c h E d i t  
The Batch Edit feature allows you to make the same change to multiple employees at the same 
time. To begin, check the box in Make Employee Changes next to the employees you want to make 
a change. Then select “Batch Edit Menu” from the Batch Actions drop-down menu.  

There are several options to batch edit. For each option, select the item(s) you would like changed 
from the drop-down menu and click “Edit.” This directs you to the appropriate screen where you 
can make the changes to the item. 
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E f f e c t i v e  D a t i ng  
The Effective Dating feature allows you to enter a change now that will take effect at some date in 
the future for one or multiple employees. Changes can be added for pay rates/salary or 
deductions. To begin, check the box in Make Employee Changes next to the employees you want 
to add the same information for an effective date. Then select “Effective Dating” from the Batch 
Actions drop-down menu.  

From this menu, you can either View Effective Dates or Add Effective Dates for the selected 
employees. To view employees with effective dates, click “View Effective Dates For Selected 
Employees.” 

Viewing effective dates will display effective dates that have not yet passed. 
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To add an effective date, click “Add Effective Dates For Selected Employees.” 

You can change pay rates or salary amounts and deduction amounts. Select the type of change 
then add the new value. Add the date the change will be effective by clicking the “Effective Date” 
field and selecting the date from the pop-up calendar. The change will take effect on the entered 
date. Any payroll submitted on the same date or after this date will have the new change reflected 
on it. 

A d d  A d d i t i o na l  F i e l d s  
If you want to view additional information from the Make Employee Changes menu, use the 
actions drop-down menu and select “Table Configuration.”  
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Simply drag and drop the fields you want to include. Any fields that display within the Grid Fields 
section will display within the menu after you click “Update.” You can add the Hire Date, Primary 
Supervisor, Position Title, Labor Allocation and Pay Type. 
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Add  P r e f e r r e d  N ame  t o  E mpl oye e  Re c or d s  
Addressing employees by their preferred name shows respect and inclusion. To support your 
employees, allow preferred names to be entered in Employee Self-Service®. Once saved, Paycom 
will continue to use legal names as required, such as on Forms W-2 and I-9. However, preferred 
names will display throughout Paycom to ensure employees are addressed by the appropriate 
name.  

First, you must grant employees permission to save preferred names in ESS Access Profiles. From 
the Employees tile, click “ESS Access Setup.”  

Then, click “Add/Edit ESS Profile.” 
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Click the appropriate profile on the Add/Edit ESS Profile screen.  

 

Scroll to the Payroll and HR Information section and enable the following permissions: 

 Allowed Preferred Name: If enabled, employees can save a preferred name within 
Employee Self-Service®. 

 Print Preferred Name on Pay Stub: If enabled, employees can elect to have their preferred 
name display on earning statements and paystubs. This permission will only display if you 
enable “Allowed Preferred Name.”  

When finished, scroll to the bottom of the screen and click “Update” to save your changes.  
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The Preferred Name field will display in Employee Self-Service® in addition to the Nickname field to 
ensure employees can document both name types. To save a preferred name, employees will 
navigate to the Address and Contact Information screen of Employee Self-Service® and click “Add 
Preferred Name.”  

Employees will enter their preferred name in the pop-up window and indicate whether the 
preferred name should display on earning statements and paystubs (if applicable). When finished, 
employees will click “Add Preferred Name.”  

Legal names will continue to display on paychecks, even if the box for “Display Preferred Name on 
Paystub” is checked. 
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Once saved, preferred names will display throughout Paycom as the employee’s name. Legal 
names will continue to appear on benefits documents, paychecks and Forms W-2, W-4 and I-9. 

As a best practice, employees should enter their preferred name in Employee Self-Service®. 
However, if necessary, you can save an employee’s preferred name within Form 1: Demographics, 
Pay Rates and Taxes. To do this, navigate to Employees > Make Employee Changes and click the 
appropriate employee’s name.   

From the Employee Menu, click “Demographics, Pay Rates and Taxes.” 
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Click “Add” next to the Preferred Name field.  

Then, enter the employee’s preferred name 
in the pop-up window and indicate whether 
the preferred name should display on 
earning statements and paystubs. When 
finished, click “Add.”  

Once saved, the preferred name will replace 
the employee’s legal name throughout 
Paycom.   
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E mpl oye e  D i r e c t or y  
Paycom’s customizable Employee Directory is full of details such as contact information, 
nicknames and birthdays, making it easy for your workforce to learn and connect with each other. 

To determine which fields display within the Employee Directory, click “Employee Directory” from 
the Employees tile.  

Then, click “Set Up Employee Directory.” 

Only users with “View and Setup” selected for the Employee Directory permission in Permission 
Profiles can set up the Employee Directory.  
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Users and/or employees can reference the Employee Directory. To enable the Employee Directory 
for your users, check the box for “Client Side.” Then, check the box next to the appropriate fields in 
the Select Details section to determine which fields are visible to users.  

You can also include up to three custom fields in the Employee Directory. In the Custom Fields 
drop-down menus, each Custom Select and/or Custom Date fields saved in Company 
Maintenance will be available for selection.  

To learn how to create and manage custom fields, please see our Company Maintenance guide 
available on the Help Menu.  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 134



 

  
 

To enable the Employee Directory in Employee Self-Service®, check the box for “Employee Side” 
and determine which fields are visible to employees. 

When finished, click “Save.” 
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The Employee Directory will update to reflect your changes.  

To access the Employee Directory in Employee Self-Service®, 
employees will click “Employee Directory” from the Company 
Information tile.  

The Employee Directory will only display if “View Employee 
Directory” is enabled in ESS Access Profiles. To learn how to 
create and update ESS Access Profiles, please see our Paycom 
Basics guide available on the Help Menu.  

From the Employee Directory tab, employees can click the arrow to view an employee’s details.   
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E mpl oye e  C h an g e  I mp or t  ( E M I0 2 )  
Paycom supports the import of employee change information using a comma delimited file. Files 
can be created in programs like Microsoft Excel or Notepad. The import file can be found on the 
Help Menu under Employee Management Forms. 

C r e at i ng  t he  Impor t  
The first step is collecting the appropriate data to include in the file. This can be done manually or 
by pulling a report. 

There are four elements that must be included in every Employee Change Report: 

 Employee Code (eecode): This is a four-character, unique identifier that must correspond 
to an employee already set up in Paycom.  

 Import Code (importcode): This code identifies the type of change made to the employee. 
To find the correct Import Code for your import, refer to the “Employee Change Import 
(EMI02)” import file on the Help Menu.  

 Child Code (childcode): This code is mandatory for certain Import Codes and can be left 
blank when it is not mandatory. To determine whether your import requires a Child Code 
and what the valid inputs are, refer to the “Employee Change Import (EMI02)” import file 
on the Help Menu.  

 New Value (newvalue): This determines what the new value for the field will become. 

In the following example, the import is changing the employee’s first name. The first name for 
employee FREM is going to be changed to “Matthew.” The Child Code for this import is not 
required. 
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In some cases, more than one new value will need to be included in the New Value field. This 
information must be separated by pipes (|). To do this, you can use the concatenate function in 
Microsoft Excel. Concatenating allows you to link together information in multiple cells into one 
cell. 

When you have multiple fields of data to enter, you first should insert your header row. This will 
ensure the information goes into the correct fields. 

Insert pipes in the second row between each item starting after column “E.” These will be used 
later to separate the items in the concatenation formula. 

Next, input the data.  

From column “E” onward, only input data in the fields for the information you wish to change. All 
other fields can be left blank. 

In Microsoft Excel, click the “Formulas” tab. Make sure you select the field beneath the New Value 
header, and then click “Insert Function.” 

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 138



 

  
 

Select the “Concatenate” formula, and click “OK.” 

Starting in column E, select each field in the second row under the headers, including the pipes, 
until you reach the field below the last header. This will insert each field into the concatenation 
formula. Each field should be in a separate text box. When finished, click “OK.” 

Column D should now appear similar to the column D shown below. 
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Next, delete the header row and all columns from column E on. Once the header row is deleted, 
you will need to copy.  

It is good practice to delete several rows following the last row in your import. This will help ensure 
the file is error-free.  

The final import file should look similar to the following: 

Save the file as a .CSV file. 

Impor t i ng  t he  F i l e  
From the Employees tile, click “Add New Employee.” 
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Then, click “Import Employee Changes.” 

Click “File” and upload the import file. Then, designate the Unique Employee ID used in the file. It 
must be one of the following options: 

 Employee Code 

 Social Security Number 

 Clock Sequence Number 

When finished, click “Continue.”  

For more instructions on how to format your import file, click the link in the blue informational banner 
or view the Employee Change Import (EMI02) import file on the Help Menu.  

  

Back to TOC  
Visit the Help Menu for the most up-to-date version of this guide. 

Employee Management | 141



 

  
 

T ax  C od e  G e ol oc at i on  Imp or t  
The Tax Code Geolocation Import allows for the upload of home addresses or coordinates to 
determine the associated tax jurisdiction.  

From the Add New Employee screen, click “Tax Code Geolocation Import.” 

Open the import file by clicking “Download” next to Import Template.  

Fill in the fields according to the header row using either coordinates or physical addresses.  

Save as a Microsoft Excel file and upload. Paycom will return a Microsoft Excel file to you with any 
local taxes that would apply.  
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New Hire Reports 
New Hire Audit Report 

New Hire Missing Fields Report 

New Hire Profile Report 



 

New H ire  Report s 
Reporting on your new hires can provide valuable insight into your hiring processes. To help you 
review the information entered in the New Hire Queue, there are three pre-defined New Hire 
Reports. In this section, we’ll review the details of each New Hire Report, so you are aware of the 
data each report provides. 

To access the New Hire Reports 
click “Report Center” from the 
Reports tile on the Main Menu. 

From the Report Center, you can 
generate reports for all the modules 
in which you have access. Click the 
“New Hire Reports” tab to view all 
the reports available. To view a 
description for each report, hover 
your cursor over the green tool tip. 
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N e w  H i r e  Au d i t  Re p or t  
The New Hire Audit Report allows you to review all new hire changes that occurred in the New 
Hire Queue during a specific date range.  

N e w  H i r e  M i s s i n g  F i e l d s  Re p or t  
The New Hire Missing Fields Report allows you to review the missing fields for pending new hires 
in the New Hire Queue. We recommend generating this report before batch hiring to ensure 
employees are not missing any required fields that would prevent them from turning active. 
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N e w  H i r e  P r of i l e  Re p or t  
The New Hire Profile Report displays information from new employee records in an easy-to-read 
format. This allows you to keep record of each new hire you’ve added to Paycom — even those 
you’ve deleted from the New Hire Queue.  

For more information, check out Paycom University for e-learning paths, quick reference guides 
and videos. Visit the Help Menu to see our Webinar Calendar, featuring upcoming live sessions on 
how to make the most of our software, as well as additional resources you can use in Paycom. 
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